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Pengantar  
 
Adobe Photoshop adalah sebuah program yang digunakan untuk melakukan perubahan-
perubahan (manipulasi) pada gambar, yang dapat menghasilkan gambar digital dengan 
kualitas tinggi. Adobe Photoshop juga dapat melakukan perubahan-perubahan dari gambar 
atau foto hasil scanner. Misalnya dengan memperbesar atau memperkecil gambar yang 
sudah ada, melakukan rotasi (perputaran), merubah warna, memberi efek-efek khusus 
seperrti yang terdapat pada menu filter. Hal yang utama dalam Adobe Photoshop adalah 
penggunaan istilah : 
 

1. Image 
Gambar yang tampak di monitor komputer sebagai salah satu file dokumen Adobe 
Photoshop setelah proses scanning. Komputer dengan software windows terbaru 
umumnya bekerja dengan jenis image . 
 
� Grafis pixel  

Ideal untuk memproduksi foto dan image lain yang berisi sejumlah besar detail 
yang tidak terstruktur. Pixel akan menyimpan informasi suatu bentuk (lingkaran, 
kotak, gambar) dalam titik-titik kecil dengan kerapatan tertentu. Biasanya image 
pixel kalau diperbesar akan menimbulkan efek buruk pada gambar (gambar 
pecah). Karena titik-titik kecil pembentuknya akan terlihat membesar dan ruang 
kosong antara titik-titik tersebut akan terlihat jelas. Warna akan terurai (pecah). 
 

� Grafis Vektor 
Adalah deskripsi matematika dari bentuk yang dapat dibuat dari garis lurus dan 
kurva. Grafis vektor sangat kompak dan portable karena dapat diperbesar dan 
diperkecil tanpa menimbulkan efek buruk pada gambar (gambar pecah). 
Contohnya apabila menggunakan software pengolah vektor atau ilustrasi seperti 
Ilustrator, Freehand dan Corel Draw. Program pengolah vektor ini sering disebut 
resolution independent. 
 

2. Pixel (picture element) 
Titik terkecil yang menyusun image. Kerapatan dari pixel dikenal dengan istilah 
Resolusi Image. Satuannya ada 2 macam yaitu pixel/inch atau pixel/cm. Contoh 
gambar dengan 72 pixel/inch artinya dalam 1 inch terdapat 72 pixel. 

 

Adobe Photoshop 6.0  
 
Sebelum mempelajari lebih lanjut mengenai cara editing dan manipulasi image pada Adobe 
Photoshop 6.0, sebaiknya mengenal terlebih dahulu area kerja sebagai media pengoperasian 
editing dan manipulasi image. Tampilan kerja Adobe Photoshop 6.0 dapat dilihat pada 
gambar 1. 
 

 
Gambar 1 Tampilan Area Kerja Adobe Photoshop 6.0 

 



Pada saat mengoperasikan Adobe Photoshop 6.0, akan terlihat tampilan seperti gambar di 
atas. Area kerja akan terdiri dari Menu bar, Option bar, Toolbox, Layer, Palet, Status 
bar. 
 

Toolbox 
 
Toolbox terdiri dari seperangkat fasilitas untuk mengedit atau memanipulasi image. Toolbox 
berada pada sisi sebelah kanan layar. Gambar 2 menunjukkan tampilan Toolbox dengan 
nama masing-masing tool. 
 

 
 

Gambar 2 : Toolbox 
 

Option Bar 
 
Seperti telah disebutkan sebelumnya, Adobe Photoshop 6.0 mengubah tampilan option 
menjadi option bar yang terletak di bawah Menu Bar. Tampilan option bar akan berubah 
secara dinamis sesuai tool yang digunakan. Sebagai contoh lihat gambar 3-5 di bawah ini :  
 
 

 
 

Gambar 3  : Tampilan Option Bar dengan Tool Marguee, Tool Cropp dan Tool Paint Bucket 
 
 

 
 
 

Gambar : 4 : Kotak Dialog New Untuk Membuat Dokumen Baru 
 
 

 
 
 

Gambar 5 : Tampilan Option Bar dengan Tool Paint Backet 
 
 

Gambar-gambar di atas menunjukkan perbedaan tampilan option bar dan penggunaan tool 
yang berbeda. Pada sisi paling kiri option bar mengindikasikan tool yang sedang digunakan. 
 
Untuk menyembunyikan tampilan option bar melalui menu Window > Hide Options. Posisi 
option bar juga bisa digeser dengan men-drag tanda bergaris dua yang berada di sisi paling 
kanan option bar. 
 



Layer 
 
Bekerja dengan Photoshop tidak akan lepas dari penggunaan layer, karena pada layer lah 
suatu image akan diedit dan dimanipulasi. Layer bisa didefinisikan sebagai lembar kerja 
yang transparan. Untuk lebih memudahkan pemahaman layer, bayangkan sebuah plastik 
berwarna bening (transparan) yang tembus pandang. Demikian halnya dengan layer, layer 
juga bersifat transparan sehingga apabila memasang image pada layer, maka bayangkanlah 
dengan memasang gambar pada  selembar plastik bening. 
Keuntungan dari penggunaan fasilitas layer adalah memudahkan pengeditan image secara 
terpisah dari suatu komposisi gambar yang kompleks. Dengan kata lain konsentrasi akan 
lebih terfokus apabila mengedit per bagian daripada keseluruhan suatu komposisi gambar. 
 
 

Membuat Dokumen Baru 
 
Sebagai pembahasan pertama pada pengoperasian Adobe Photoshop 6.0 adalah membuka 
dokumen baru dan melakukan setting pada dokumen yang akan dibuat. Untuk membuat 
dokumen baru pilihlah menu File > New, maka akan muncul kotak dialog untuk melakukan 
setting pada dokumen yang akan dibuat tersebut. 
 
 

 

Gambar 6 :  
Kotak Dialog Membuat Dokumen Baru 

 
Penjelasan Gambar 6 : 

 
� Name : Untuk memberikan nama pada dokumen yang baru, misalnya dokumen tersebut 

diberi nama Pelatihan. 
� Width : Untuk menentukkan lebar dokumen yang dibuat. Secara default nilai ukuran 

lebar akan ditentukan dalam pixel. Apabila belum terbiasa dengan pemakaian pixel, 
gantilah dengan mengklik list box, sehingga akan muncul beberapa pilihan, yaitu Inches, 
cm, points, picas, coloumn. 

� Height : Untuk menentukkan tinggi dokumen. Seperti juga Width, secara default nilai 
ukuran tinggi juga ditentukan dalam pixel. Nilai ukuran juga bisa diganti, misalnya ke 
dalam cm (gambar 6). 

� Resolution : Untuk menentukan resolusi image yang nantinya berkaitan dengan 
pencetakan. 

� Mode : Untuk memilih mode warna. Di sini terdapat pilihan mode warna yang disediakan 
Photoshop, di antaranya RGB, Bitmap, CMYK dan lainnya. Tetapi sebagai default nya 
adalah mode RGB. 

� Contents : Untuk menentukan tampilan pertama dokumen. Pilihlah salah satu dari 
ketiga pilihan yang ada. Apabila memilih White, maka tampilan dokumen pertama kali 
akan berwarna putih. Jika memilih Background Color, tampilan dokumen akan sesuai 
dengan warna yang terdapat pada kotak Background. Sedangkan jika memilih 
Transparent, maka tampilan dokumen akan menjadi transparan. Sebagai contoh akan 
dipilih White. 

 
Setelah menentukan pilihan terhadap dokumen yang akan dibuat, klik OK maka 
dokumen baru akan tampil di layar Photoshop.  
 



 
 

Gambar 7 : Membuat Dokumen Baru 
 

 

Lebih Detail Tentang Resolusi  
 
Resolusi adalah istilah yang dipakai untuk merepresentasikan banyaknya titik gambar dalam 
satu inci persegi (atau cm). Pada monitor, titik titik ini dinamakan pixel atau dot, sedangkan 
pada hasil cetak, dipakai istilah dot atau lines. Tujuan utama dari menentukkan resolusi 
gambar adalah untuk mendapatkan informasi yang cukup untuk menghasilkan output yang 
baik dengan tetap berusaha mendapatkan file yang sekecil mungkin. Jadi untuk menentukan 
resolusi kita harus mengetahui kemampuan alat output. 
 
Monitor dan hasil cetak mempunyai perbedaan yang mendasar dalam merepresentasikan 
gambar. Yang kita lihat pada monitor merupakan barisan pixel sedangkan yang kita lihat 
pada hasil cetak merupakan titik-titik halftone. Monitor hanya mampu untuk menampilkan 
72 dpi (meskipun file mempunyai resolusi 300 dpi), sedang hasil cetak mempunyai resolusi 
yang berbeda-beda, surat kabar menggunakan 35 lpi (line per inch) atau kurang, majalah 
dengan kertas uncoated menggunakan 100-120 lpi, sedang kertas coated menggunakan 133 
lpi atau 150 lpi. Secara kasar, perbandingan yang baik antara resolusi gambar pada 
komputer dan hasil cetak berkisar antara 1,5 : 1 atau 2:1. Jadi untuk mencetak dengan 
resolusi 150 lpi, memerlukan resolusi sekitar 225 hingga 300 dpi. 
 

Bit Depth 
 
Bit depth adalah besarnya informasi data dari 1 satuan sampel (dot/pixel). Setiap 
bitmap/dot/pixel bisa berupa hitam, putih, abu-abu atau warna. Bit depth dinyatakan 
dalam angka yang digunakan untuk menyatakan berapa variasi warna yang mampu 
ditampilkan oleh suatu bitmap/dot/pixel yang dinyatakan secara kuantitatif. 
Rumusnya adalah 2ⁿ (dua pangkat n, dimana n adalah besarnya bit depth). 
 
Contoh : 
 

� 1 bit = 2 = variasi warna 
� 2 bit = 2 = 4 variasi warna 
� 4 bit = 2 = 16 variasi warna 
� 8 bit = 2 = 256 variasi warna 
� 16 bit = 26 = 2 kombinasi 8 bit = 65.536 variasi warna 
� 24 bit = 2= 3 buah kombinasi 8 bit = 16.777.216 variasi warna 
� 32 bit = 2 = 4 buah kombinasi 8 bit = 4.294.967.296 variasi warna. 

 
 
 
 
 



Warna 
 
Photoshop menyediakan beberapa cara untuk merepresentasikan warna yang bisa dipilih 
dengan memilih Edit/ Mode. Penggunaan color mode yang tidak perlu berpengaruh pada 
kecepatan kerja. Perlu diketahui bahwa pada deafult Adobe Photoshop 5.5/6.0 : 
 

o Mode Grayscale memiliki bit depth 8 bit 
o Mode RGB memiliki bit depth 24 bit  
o Mode CMYK memiliki bit depth 32 bit 
 
Keterangan :  
 
Semakin besar bit depth akan mengakibatkan semakin besar ukuran file dan berakibat 
kecepatan kerja berkurang. Oleh karena itu, usahakan menggunakan mode warna sesuai 
keperluan dan kemampuan.  
 
Misalkan :  

o Untuk menscan gambar hitam putih, gunakanlah mode warna B/W (black and 
white) Photo atau grayscale. 

o Untuk menscan teks, gunakanlah mode warna B/W document atau grayscale. 
 
Penggunaan color mode RGB pada saat scanning pada gambar hitam putih/ grayscale 
dapat menimbulkan distorsi warna (warna hitam yang terbaca bukan warna hitam asli 
atau hasil prosentase campuran dari warna hitam melainkan campuran dari warna red, 
green dan blue). Ingat warna red, green dan blue juga dapat menimbulkan warna hitam.  

 
� CMYK merupakan sistem representasi warna untuk proses cetak 4 warna : Cyan, 

Magenta, Yellow (kuning) dan K (hitam). Dengan sistem ini gambar akan disimpan 
dalam 4 channel. 

� RGB merepresentasikan gambar dengan 3 channel, red (merah), green (hijau) dan 
blue (biru). Masing-masing channel disimpan sebagai informasi 8 bit yang akan 
mempunyai 256 nilai gradasi. Jadi yang bisa direpresentasikan dengan sistem 24 
(8x3) bit ini adalah 16 juta variasi warna dari kombinasi ketiga channel. 

� Indexed Color hanya mampu merepresentasikan maksimal 256 variasi warna 
dengan informasi 8 bit atau kurang. Proses mengubah dari informasi RGB 24 bit 
menjadi 8 bit atau kurang disebut indexing. Untuk mendapatkan hasil terbaik pada 
saat melakukan indexing adalah dengan pilihan Adaptive karena pilihan ini akan 
mengambil warna yang paling banyak muncul pada gambar. Pilihan Custom 
digunakan bila ingin menggunakan palet warna tertentu, sedang Previous 
(sebelumnya) akan menggunakan palet warna dari gambar yang diproses 
sebelumnya. 

� Lab Color menggunakan sistem representasi berdasarkan luminance/lightness dan 2 
komponen chromatic, komponen a, dari hijau ke merah dan komponen b, dari biru ke 
kuning. Sistem ini mampu merepresentasikan semua color gamut yang dipakai baik 
pada sistem CMYK maupun RGB karena sistem ini didesain untuk merepresentasikan 
warna yang konsisten dan tidak bergantung kepada alat tertentu. 

� Grayscale hanya menyimpan nilai brightness dari suatu gambar dan mempunyai 
informasi 8 bit dengan 256 variasi kecerlangan. 

� Duotone merepresentasikan gambar menggunakan 2 warna dengan 256 variasi 
gradasi, sedang Tritone dan Quadtone masing-masing 3 dan 4 warna. 

� Bitmap hanya menyimpan warna sebagai informasi 1 bit, ada titik atau tidak ada 
titik (hitam atau putih).  

 

Format File 
 
Untuk kompatibilitas dengan aplikasi-aplikasi lain, Photoshop menyediakan berbagai format 
file yang bisa Anda pilih dengan File/Save atau File/Save As atau File/Export. 
 
� Photoshop Document (.psd) hanya satu-satunya format yang bisa menyimpan 

informasi layer. Pastikan bahwa Anda sudah melakukan Flatten Image 
(menggabungkan layer menjadi 1) pada palet Layers bila terdapat beberapa layer. 

� Bitmap (.bmp) merupakan standar windows dan format ini bisa menyimpan 
informasi gambar mulai dari 1 hingga 24 bit. 

� Encapsulated Postcript (.eps) memungkinkan file ditransfer ke Adobe Illustrator 
atau Adobe PageMaker. 

� Joint Photographic Experts Group (.jpg) adalah format dengan sistem kompresi 
yang mengurangi mutu gambar berdasarkan pilihan yang diinginkan. Pilihan 
Excellent (sangat baik) pada saat menyimpan akan terlihat hampir mirip dengan 
gambar aslinya. Format ini hanya mampu menyimpan channel RGB atau CMYK tanpa 



alpha channel. Gunakan format ini untuk menyimpan gambar foto, background (latar 
belakang) atau mapping (pemetaan) untuk dibaca di 3Dstudio. 

� Compuserve (.gif) Graphics Interchange Format didesain untuk memungkinkan 
pertukaran file secara cepat melalui modem. Karena itu file ini hanya bisa 
menyimpan informasi maksimum 8 bit (Grayscale atau Indexed Color). Gunakan 
format ini untuk menyimpan gambar Graphic atau tekstur untuk dibaca di 3Dstudio. 

� Tagged Image File Format (.tif) mampu menyimpan informasi 24 bit dengan 
Alpha Channel dan didesain untuk mendukung tukar menukar file antar platform 
(IBM, Macintosh & Silicon Graphics) 

� Targa (.tga) mampu menyimpan informasi 24 bit dengan kualitas true color (16 juta 
warna). Banyak dipakai untuk menyimpan gambar hasil render program animasi 
seperti 3Dstudio. 

 
 

Fasilitas Istimewa Untuk Desainer Web 
 
Bagi anda yang menggunakan Adobe Photoshop untuk mempersiapkan desain interface 
web, pasti akan menyukai Adobe Photoshop versi 5.5 atau 6.0. Karena Adobe Photoshop 
versi tersebut menyediakan beberapa fasilitas yang mempermudah para web desainer 
dalam menyiapkan desain interface web. Fasilitas-fasilitas tersebut adalah : 
 

1. Fasilitas color gamut for web 
Fasilitas ini akan ditemui pada saat memilih warna. Bila anda memilih warna dengan 
mengklik icon foreground color atau background color, maka akan muncul dialog box 
(kotak dialog) color picker.  
 
Pada dialog box terdapat color gamut for web warning. Selain itu anda bisa 
membatasi warna yang ditampilkan hanya untuk aplikasi web. Fasilitas ini dapat 
digunakan dengan mengaktifkan check mark only web color yang terdapat pada 
bagian bawah kotak warna. Fasilitas ini menjamin tampilan warna yang sama ketika 
anda memilih warna tersebut dan ketika menampilkan pada halaman web.  
 

 
 
Gambar 8 : Out of Gamut for Web Warning 

 
2. Penyimpanan untuk aplikasi web 

Adobe Photoshop 5.5 dan 6.0 menyediakan fasilitas penyimpanan file untuk 
dipergunakan pada halaman web. Anda dapat menggunakan fasilitas ini dengan 
memilih File > Save for web pada menu bar. 
 
Setelah itu akan muncul kotak dialog pengaturan jumlah warna dan file format yang 
harus Anda pilih terlebih dahulu sebelum Anda mengeksekusinya. Fasilitas ini 
membantu Anda menyimpan gambar untuk diaplikasikan pada halaman web dengan 
pilihan format dan bit depth yang disesuaikan dengan kebutuhan web. 
 

Fasilitas Pengaturan Teks 
 
Fasilitas pengaturan teks dapat Anda temui pada kotak dialog type tool. Fasilitas tersebut 
adalah :  
 

1. Underline  
Fasilitas ini berguna untuk memberi garis bawa pada teks 
 

2. Faux Bold 
Fasilitas ini berguna untuk menebalkan teks walaupun font yang digunakan tidak 
memiliki versi bold. 



3. Faux Italic 
Fasilitas ini berguna untuk membuat teks italic/ miring walaupun font yang 
digunakan tidak memiliki versi italic. 

4. Anti Alias  
Fasilitas ini berguna untuk memperhalus pinggiran huruf. Dalam Adobe Photoshop 
5.5/ 6.0 terdapat 3 pilihan anti alias, yaitu : 

o Crisp.  
Untuk mendapatkan pinggiran huruf yang lebih tajam 

o Smooth  
Untuk mendapatkan pinggiran huruf yang lebih halus 

o Strong 
Untuk mendapatkan pinggiran huruf yang lebih kuat. 
 
Dengan mata telanjang memang ketiga pilihan tersebut tidak terlalu berbeda 
hasilnya, terutama apabila teks yang diamati berukuran kecil. 
 

5. Auto kerning dan manual kerning  
Fasilitas kerning adalah fasilitas yang berguna untuk mengatur kerapatan kiri kanan 
antar huruf. Anda dapat mengaktifkan fasilitas auto kerning dengan menandai check 
mark auto kerning pada kotak dialog teks tool. Untuk mengatur kerning sendiri, Anda 
dapat menonaktifkan auto kerning dan mengisi angka yang Anda inginkan untuk 
kerning. 
 

6. Fractional widths 
Ketika Anda membuat tulisan untuk aplikasi web, fractional widths sebaiknya 
dinonaktifkan agar bentuk hurufnya tajam karena tidak jatuh di tengah-tengah  pixel. 

 

 
 

Gambar 9 : Fasilitas Pengaturan Teks dalam Kotak Dialog Teks Tool  
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